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Freeze Frame

FreezeFrame is a computerized system for the Conditioned Fear Test that combines the sensitivity of the 
human observer with the objectivity and convenience of automation.

While infrared beams or video tracking systems can detect gross movements of an animal from one part of 
the cage to another, FreezeFrame can detect the minute movements of grooming, sniffing, turning and 
rearing.

By recording from 4, 8 or even 12 animals at once, FreezeFrame is ideal for high-throughput testing of large 
numbers of animals.

●     Not a tracking system. FreezeFrame uses a proprietary motion detection algorithm that filters 
out shadows, light flicker and camera noise.

●     Detects movements as small as 1 mm. 
●     Fully validated. >90% concordance between FreezeFrame and a trained human observer.
●     Multiple stimulus protocols can be stored for training and testing phases of the experiments.
●     Display images on the computer screen. No external monitor necessary.
●     Store images for later review.
●     Export data and analyses in spreadsheet format.
●     Easy setup. 

�❍     Sounds (white noise or tone) are delivered through the computer's speakers. 
�❍     The shocker-scrambler is controlled directly from the computer. 
�❍     2 additional external stimuli may be controlled as well.

4-Hz sampling frequency.

4, 8 and 12 channel systems

●     Record 4 animals at once using a single computer and camera with the FreezeFrame 4-channel 
system. 

●     Use 1 camera to record from 4 chambers or 1 camera for each chamber. 
●     Record 8 or 12 animals with 2 or 3 linked computers, each running the FreezeFrame 4-channel 

system. 
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System Requirements 

Computer

FreezeFrame runs on Windows 9X/NT/2000/XP computers. We recommend:

●     Pentium IV with a 1.2 GHz or faster processor 
●     1 Gigabyte of memory 
●     Windows XP
●     15" monitor or larger (1280 x 1024 resolution)
●     Sound card and speakers
●     If you plan to store the acquired images, a CD or DVD writer for backing up data files.

Hardware

Camera. A black-and-white CCD camera with NTSC format output (supplied)

Image Acquisition board. National Instruments PCI-1405, PCI-1410 depending on 
configuration (supplied).

Shocker-scrambler, cage and cables. FreezeFrame will connect easily to most 
available fear conditioning hardware.
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Hardware Installation

FreezeFrame can be used with National Instruments video acquisition boards, the PCI-1405, 1407, 1408, 
1409 or 1410. 

Before installing the video board, load the NI-IMAQ software from the CD provided 
with the video board.  
Shut down the computer and plug the PCI-140X board into the open PCI-slot that is 
closest to the processor.  
Restart the computer.

Camera connections

Single camera 

●     Connect the camera output connector to the "Video" input BNC on the PCI-14XX using the BNC 
cable provided.

●     Connect the camera to a 24VAC power supply using the two-stranded wire provided. Polarity is 
unimportant.

●     Plug the power supply into any 120V- 60Hz or outlet. 

●     Two cameras (See diagram below)

●     Set up camera one as described above.
●     Connect the multi-pin cable assembly provided to the PCI board. 
●     Connect the "video out" BNC connector on cameras 2 V0 and V1.
●     Connect the CSYNCOUT BNC on the video board to the T connector on camera 2. 
●     Connect cameras to 24VAC power supply as above. One power supply can be used to both 

cameras.
●     Plug the power supplies into any 120V-60Hz outlet.

●     Four cameras (See diagram below)

●     Connect the multi-pin cable assembly and breakout box (A6822) to the PCI board. 
●     Connect the "video out" BNC connector on cameras 1 2, 3 and 4 to V0, V1, V2 and V3.
●     Put one BNC T-connector on the GEN LOCK (or SYNC IN) plug on cameras 2 and 3. 
●     Connect the CSYNCOUT BNC on the video board to the T connector on camera 2. 
●     Connect the other side of the T-connector on camera 2 to the T-connector on camera 3. 
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●     Connect the other side of the T-connector on camera 3 to the GEN LOCK/SYNC IN connector on 
camera 4.

●     Connect each camera to a 24VAC power supply as above.Each power supply can be used to 
power 2 cameras. 

●     Plug the power supplies into any 120V-60Hz outlet.

 

Configure the PCI-14XX

●     Double-click the Measurement & Automation icon on the desktop, or from Windows's START 
menu, select Programs->National Instruments IMAQ -> Measurement and Automation. A 
Window entitled "MAX" should appear.

●     In the list to the left of the window, open My System\Devices and Interfaces\IMAQ PCI-14XX
\img0\Channel 0: rs 170

●     From the Toolbar just underneath the menu bar, select IMAQ->Grab. You should now see a real-
time image from camera 1. If no image appears, check the power and signal connections from the 
camera and video board. If you still have trouble, call National Instruments at 800-433-3488 and 
ask for help with NI-IMAQ. 

●     Close the MAX window.
●     For all systems: Select "Channel 0: RS-170" in the configuration list. and click the Properties 

tool in the toolbar. Set the Bit Depth to "8 bit" in the dialog box that appears and then click OK.
●     For multiple camera systems only: Select IMAQ PCI-14XX: img0 in the Configuration list and 

click on the Properties tool in the toolbar. Select the Operating Mode tab in the dialog box that 
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appears. Set Slave Acquisition Mode to "CSYNC External". CSYNC Source will be set to 
"Channel 0". Click OK. 

●     For multi-camera setups, select and then try the grab for each Channel.
●     Close the MAX window. 

Configure the computer's speakers and sound card

FreezeFrame relies on the computer's sound card and speakers for generating 
conditioning stimuli. Connect the computer's speakers as in your computer manual and 
test the sound system. You can test the system by playing a CD (from the START 
menu, choose Accessories->Multimedia->CD Player), or by opening the Sounds 
control panel, selecting a sound and playing it using the rightward pointing arrow 
("Preview:").

If the sounds do not play, check the speaker connections, whether they are turned on 
and whether the volume is set high enough. Next check whether the drivers for the 
sound card that came with the computer are properly installed and functional. If they 
are not, consult with the computer manufacturer. 

If you are able to play a CD or a sound in the Sounds control panel, FreezeFrame 
should be able to play conditioning stimuli as well.

Connect the Shocker to the computer 

PCI-1405 or 1407. Connect the shocker control input to the BNC connector labeled 
"TRIG" on the PCI-1407.The TRIG connector provides a 5V (TTL-compatible) 
signal. Check with the shocker manufacturer to make sure that a TTL signal is 
sufficient for triggering their device.

PCI-1408, 1409 or 14010. Connect the interface cable to the multipin connector on 
the PCI-1408/1409. Stimuli 2-4 (shock and 2 auxilliary outputs) correspond to the 
BNC connectors labelled T0, T1 and T2, in order.

Connect the Shocker to the cage

Details will vary depending on the shocker and cage you have. Consult the 
manufacturer's instructions.
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Camera mounting

The camera can be mounted on any standard camera tripod or mounting bracket using a 1/4-20 screw. For a 
single channel system, the exact placement of the camera is not critical. The camera can be aimed from 
directly above the cage, or in front of and slightly above the cage, looking down from a 45 degree angle. 

Alternatively, if the rear walls of the chambers are clear, the cameras can be mounted behind the chambers. 
This leaves the front of the chambers clear for easier loading of animals. One difficulty the rear-mounted 
cameras introduces is possible artefacts from the user walking in front of the chambers during a trial. Be sure 
to make the front door of the chambers opaque and to block off the space between the chambers so that the 
camera cannot see the space in front of the chambers. 

Adjusting Image Quality (Important)

There are 5 critical adjustments that must be made to the image in order to insure proper operation of 
FreezeFrame. If any one of these conditions is not met, the system's sensitivity will suffer, as will the 
accuracy of your results. An example of a good camera setup is shown in the image below.

1) Camera position. Position the camera and adjust the zoom of the lens so that the cage fills the image as 
much as possible. For 1-camera setups, 
position the 4 cages as close together as 
possible.

2) Camera angle. Position the camera in 
front of the cage so that all of the cage floor 
is visible. With a 1-camera setup, it might be 
necessary to angle the right-hand cages to the 
left and vice versa so that the camera sees 
straight in to each cage. 

3) Focus. Take extra care to focus the image 
properly. Incorrect focus will degrade the 
program's ability to detect fine movement.

4) Lighting. The absolute lighting level is not critical, as long as there is enough light in the chamber to 
give a clear image on the screen. If you do not have a auto-iris lens (one with a short wire that plugs into the 
camera), adjust the aperture manually so that a clear image is visible on the screen.
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●     With the aperture set to be too large, areas of the image will become uniformly white or washed 
out. 

●     With the aperture set to be too small, the image will become dark and grayed out. 
●     With the aperture set in the right range, small lighting changes will make little difference in the 

appearance of the image since they are compensated for by the automatic gain control of the 
camera 

5) Reflections. It is critical that there be no glare from highly reflective objects on the sceen. If you see 
light glinting off any shiny surfaces (that is, saturated parts of the image that are comletely white), adjust the 
lighting or camera angle, or as a last resort put tape over the reflective surface. Similarly, there should be no 
completely black areas of the image. An important check for too bright or too dark regions of the image is to 
run the FreezeFrame data collection program and view the images in Difference (Diff) Mode (see the 
FreezeFrame main window description). Most of the image should appear as grey snow that changes from 
frame to frame. Saturated parts of the image will appear a flat grey with no speckling and no change from 
frame to frame. It is important to minimize these areas by changing the lighting or the objects in the field of 
view.

Once the lighting is set, it should not be changed from trial to trial.

1 camera - 4 chamber systems

The multichannel system cuts the image up into 4 quadrants of equal size and performs the motion 
calculation independently on each image. The simplest arrangement is to cluster the 4 cages into a 2x2 array 
and point the camera at the entire array from above. Alternative arrangements are possible as well. For 
example, 2 upper cages can be set above and slightly set back from the 2 lower ones, and the camera pointed 
from in front of slightly above the array. 

Make sure that the image of each cage is confined to its own image quadrant. This is most easily checked in 
the program, using the controls that allow viewing of each quadrant independently. 
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Multiple-Computer Systems (8 or 12 channels)

Install FreezeFrame hardware and software

Install the software and hardware on each computer as described 
in the Installation section.

Identify the Master and Remote Computers

Select one computer (typically, the one with the fastest 
processor) to be the Master computer, and the second (and 
possibly third) computer to be Remote 1 (and 2).

Shock and Sound control.

You may connect all speakers and shockers to the Master 
computer. Alternatively, you may connect some speakers and 
shockers to the Remote computers as well. The program runs in 
near synchrony on the different computers and each puts out 
similar control signals.

If you will have each computer control various stimuli, be 
sure to set the Stimulus Polarity (Normal/Invert) controls 
independently on each computer using the Output 
Configuration window. 

All stimulus timing and Sound stimulus properties on the 
Remote computers are inherited from the Master and so do not 
need to be set on the Remote. 

Connect the Computers 

Using the cables provided (with 9-pin connectors on each end), 
connect the COM1 (serial) port on the Master computer to the 
COM1 port on Remote 1.Some cables come with both 9-pin 
serial port connectors and 25-pin parallel port connectors on 
each end. Only the 9-pin connectors need be plugged in. 
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Connect the COM2 port on the Master computer to the COM1 
port on Remote 2. 

Configure FreezeFrame

Run FreezeFrame and use the File->To Master menu item to 
configure the Remote computers as Remotes. 

On the Master Computer, activate the connections to the 
Remotes using the Settings->Remote 1 and Settings->Remote 2 
menu items.
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The FreezeFrame Recorder Menus and Controls

FreezeFrame starts running when it opens. With the camera and image acquisition board properly 
configured, you should see the camera image(s) in the window updating about 4 times per second. An 
asterisk (*) on the controls below indicates that the setting of the control is telegraphed automatically to the 
Remote computers, if present.

File Menu

Data File. Use this menu item to select the file into which all data will be written. The 
currently selected file is displayed in the indicator underneath the image window. If 
the directory chosen for some reason does not exist, an warning indicator will appear. 

To Remote/To Master. If you are using FreezeFrame on multiple computers that are 
connected to one another, use this menu item to configure the program as either a 
Master or Remote. In Master mode, the program controls the Remote computers, 
starting and stopping trials, and determining stimulus sequences. The Remotes in turn 
report their data back to the Master.

Quit. Exits FreezeFrame.

Operate Menu

Names. Opens a window that allows you to enter all the names for a trial in a single 
one-dimensional list. The TAB key moves the cursor from one trial to the next. 

Avid IDs. Applicable only if you have Avid ID chips in your animals and an Avid 
chip reader connected to your computer. Contact Actimetrics for information. 

Reference*. Collects a reference frame for later tracking of the animal. Same as 
clicking the Reference button underneath the image window. Collect a reference 
frame before placing the animal in the chamber. 

Start*. Starts a trial.Same as the Start button. Commands the Remote computers to 
start at the same time.

Stop*. Aborts a trial without saving data. Same as the Stop button. Commands the 
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Remote computers to stop as well.

Settings Menu

Protocols. Opens the Protocol window for designing the stimulus sequence of the 
protocols.

Stimulus Configuration. Opens the Stimulus Configuration window, for setting the 
polarity of the shock and auxilliary control signals, and the sound stimulus 
characteristics. 

Camera Setup. Opens the Camera Setup window, for setting the frame rate and the 
number of cameras. 

Save Images*. Tells FreezeFrame to create an image file for each recorded animal. 
During the trial, each recorded image is stored in a file called <animal>.ffii, where 
<animal> is the name of the animal specified in the Animal Names control (below). 
The ffii file is located in the same directory as the data file.

Invert Vertical. When checked, inverts the image in the image window. 

Invert Horizontal. When checked, flips the image left-to-right. 

Remotes.

Remote 1. When checked on the Master computer, tells 
FreezeFrame to control and read data from Remote computer 1. 
Remote 2. When checked on the Master computer, tells 
FreezeFrame to control and read data from Remote computer 2. 
Remote 2. When checked on the Master computer, tells 
FreezeFrame to control and read data from Remote computer 3.

Avid Setup. Applicable only if you have Avid ID chips in your animals and an Avid 
chip reader connected to your computer. Contact Actimetrics for information. 

Large View. The program can be setup for two screen sizes. With Large View 
checked and multiple animals being monitored, the program will show all animals at 
once. Requires a display with 1280 x 1024 resolution. With Large View unchecked, 
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only one animal at once is shown in a smaller format. Appropriate for displays with 
1024 x 768 resolution. 

Help Menu

Help. Open this help file.

About FreezeFrame. Displays the Version number and Serial number. 

Controls and Indicators

Animal Names Control

Local. An array of text boxes is located to the upper left corner of the FreezeFrame 
window. Prior to a trial, enter the names of the animals to be run into the controls. For 
1-camera setups, the four controls correspond to the four quadrants of the image. For 4-
camera setups, the 4 controls correspond to the 4 cameras, in the order upper left, 
upper right, lower left, lower right. These names are used to identify each trial in the 
freeze data file, and are used as the names of the image files if images are to be saved. 
As you enter each name, FreezeFrame checks the current data directory for an image 
file of that name and warns you if one exists by showing an "Overwrite" indicator in 
the space below the Names controls and disables the start button. Use the TAB key to 
move from one text entry box to the next.

Remote*. With FreezeFrame in the Master mode, and the Remote 1 or Remote 2 
menu items checked, one or two more sets of Animal Names controls appear below 
the Local control. Enter names for the animals to be run on the remote computers here. 
The names are sent to the Remote computers and will appear on their screens. 

Motion Index Indicators

Local. To the right of the Name controls is an array of indicators. The numerical 
indicator shows the motion index for each camera or image quadrant. The light below 
the indicator indicates freezing whenever the motion index falls below 10. This is only 
a rough guideline. The real threshold for freezing will be set in the FreezeView 
Analysis program.

Remote. With FreezeFrame in the Master mode, and the Remote 1, 2 or 3 menu items 
checked, additional sets of Motion Index indicators will appear below the first, one for 
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each Remote computer. Data are sent automatically from the Remotes and appear in 
these indicators. If the Remotes are not operating properly or the cable is not 
connected correctly, a No Data warning will appear. Similarly, an error indicator will 
appear if the serial port is not responding properly. 

View Control

Click on the different buttons in the View control to view the image from each of the 4 
cameras or from each of the 4 quadrants of the image. On 1-camera systems, click the 
View All toggle switch to view all the quadrants of the image at once. 

TV/Diff Control

In TV mode, the image from the camera is displayed directly. In Diff mode, the image 
display shows the difference between the current and previous images.

Reference/Start/Stop*

These buttons control the start and end of a trial. See the corresponding menu items 
above.

Data File and Free Indicators

The Data File indicator shows the currently selected data file. Change the file using the 
FILE->OPEN menu item. The Free indicator shows how much space is available on 
the disk containing the current directory. The File Size indicator appears during a trial 
and shows the size of each of the image files being saved.

Frame Rate Indicators

The Frame Rate indicator is most often not visible. It will appear only when 
FreezeFrame cannot collect and process images as fast as has been requested using the 
Frame Rate control in the Camera Setup window. When this condition occurs, the 
Frame Rate indicator will show the actual frame rate. A low frame rate does not 
affect the data collection seriously. See the Camera Setup window for details on how 
to set the frame rate. 

Protocol Selector Control*
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The protocol Selector is a popup menu to the lower left of the FreezeFrame window. 
The items in the menu are set by the user in the Protocol Window. The selected 
protocol is sent automatically to the Remote computers.

Protocol and Stimulus Display

The chart at the bottom of the screen gives a graphical indication of the protocol 
sequence. Horizontal bars in the four rows of the display show when each stimulus 
will come on during a trial. The time scale of the display also varies to indicate the 
duration of the trial. During a trial, a vertical yellow cursor scolls across the display to 
indicate the progress of the trial. As each stimulus is turned on and off, the four 
indicators to the right show the current status of the stimuli.
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Setting up the protocols

Protocols in FreezeFrame are configured using the Protocol window. Open the Protocol window from the 
Main FreezeFrame window by selecting the Setting->Protocols menu item.

All changes you make in the protocols are saved automatically and immediately. 

Protocol. FreezeFrame will store up to 20 different stimulus protocols. Select the protocol you wish to 
change using the Protocol pop-up menu. 

Name. You can give each protocol a different name (though it is not necessary to do so). Simply type the 
name into the text box. The name will appear in the Protocol popupmenu as well.

Trial Duration. This is a text control specifying the total duration of the recording session in minutes:
seconds. "5:00" is equivalent to "300", and specifies a trial duration of 300 seconds. The control will flash 
red when it is set to 0 as a reminder to change it to a more reasonable value. Trials of greater than 60 minutes 
are possible but not recommended. 

Setting the stimuli

There are 4 different stimulus channels available when using a PCI-1408 or 1409: sound, shock, stimulus 3 
and stimulus 4. Sound is delivered through the computer's speakers. Shock, stimulus 3 and stimulus 4 are 
delivered through the T0, T1 and T2 outputs of the 1408/9. These are TTL compatible outputs, delivering 0V 
when in the low state and 5V when in the high state. In the Output Configuration window, you may 
configure each input to be low (0V) when ON (Normal polarity) or high (5V) when ON (Inverted polarity).

The PCI-1407 provides only a single TTL ouput (Shock) through the BNC connector marked TRIG.

Onset/Duration array. You may specify up to 50 different stimulus epochs for each protocol. For each 
stimulus epoch, you must specify an onset time and a duration. Onset and duration may be entered as 
minutes:seconds, or as seconds. For example, "5:10" is equivalent to "310", and "1:45" is equivalent to 
"105".Perforce, a stimulus will not be delivered if its onset time exceeds the Trial Duration setting. 

The values below will turn on the sound for 30 seconds at 3, 6 and 9 minutes into the trial. At the end of each 
sound, the shock will be delivered for 5 seconds. 
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1 3:00 30 6:00 30 9:00 30 sdfdsf sdfdsf

2 3:30 5 6:30 5 9:30 5 sdfdsf sdfdsf

3 sdfdsf sdfdsf sdfdsf sdfdsf sdfdsf sdfdsf sdfdsf sdfdsf

4 sdfdsf sdfdsf sdfdsf sdfdsf sdfdsf sdfdsf sdfdsf    sdfdsf

Multiple Sound Stimuli. If you plan to use more than one type of sound stimulus (with different 
frequencies, pure tone or noise, different loudness, etc), then you must first set up the different sounds in the 
stimulus configuration window. It is possible to configure up to 10 different sounds. In the case that more 
than one is to be selected, you must specify which sound is to be used for each stimulus epoch in the 
protocol setup as shown below. Simply prefix the Onset time with the sound number and a "-". In the 
example below, the first epoch will present sound 2, the second sound 4 and the third sound 3. If no prefix is 
given (as in the above example), sound 1 will be used by default.

1 3-3:00 30 4-6:00 30 3-9:00 30 sdfdsf sdfdsf

2 3:30 5 6:30 5 9:30 5 sdfdsf sdfdsf

3 sdfdsf sdfdsf sdfdsf sdfdsf sdfdsf sdfdsf sdfdsf sdfdsf

4 sdfdsf sdfdsf sdfdsf sdfdsf sdfdsf sdfdsf sdfdsf    sdfdsf

Epoch. Onset and duration times are visible only for 8 epochs at a time. To view epochs other than the first 
8, use the Epoch numerical control or the >> and << buttons on the left sode of the window. Also, with the 
NumLock control on your keyboard off, the <End> and <PageDn> keys will scroll the Onset/Duration array 
right or left.

Protocol Chart Display. As you enter times and durations for each epoch, a colored bar will appear in the 
chart at the bottom of the screen to give a picture of the entire protocol stimulus sequence.

Clear all. This button will delete all stimuli from the current protocol.

Exit. Closes the Protocol window.
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Camera Setup Window

FreezeFrame can be used in 4 different configurations, depending on the hardware being used.

1 camera - 1 chamber. In the simplest configuration, FreezeFrame uses a single camera to view a single 
shock chamber.

2 cameras- 2 chambers. If a PCI-1408 or PCI-1409 is being used, you may connect 2 cameras to the board, 
each one viewing a different chamber.

4 cameras- 4 chambers. If a PCI-1408 or PCI-1409 is being used, you may connect 4 cameras to the board, 
each one viewing a different chamber.

1 camera- 4 chambers. With any of the boards, you may configure FreezeFrame to view 4 chambers with a 
single camera. In this case, the image is divided into 4 quadrants and the motion detection algorithm is 
performed independently on each quadrant. The chambers must be placed in a 2 x 2 array so as to fit one into 
each quadrant of the camera image. This can be a side-by-side array with the camera looking down from 
above, or a 2-up 2-down array with the camera looking from the front. In this case, the upper two chambers 
can be set back from the lower two slightly, so that the camera can look from in front, and slightly above the 
array (see Camera Setup).

Frame Rate. This control sets the rate at which FreezeFrame collects images and analyzes them. The 
maximum rate allowable will vary depending on how many cameras are being used, how many chambers are 
being analyzed, and how fast the computer clock processor is. A computer with a clock speed of 800 MHz or 
better can likely collect at 4 Hz with any configuration, and this is the default setting. With only 2 cameras 
and 2 chambers, a faster rate is possible, but not advisable for the reasons outlined below.

If the frame rate is set to be faster than the computer can handle, Frame Rate indicator will appear during a 
trial. This is not at all fatal to a trial. The data will be collected properly, but at a slower rate than is set in the 
Frame Rate control.

The 4 Hz rate is the fastest that is advisable. At faster rates, a trade-off begins to occur between temporal 
resolution in the data and motion detection threshold. The shorter the time between frames, the less the 
animal has a chance to move between frames and so the minimum detectable motion will decrease slightly. 
Frame rates lower than 4 Hz will not likely increase the motion detection threshold significantly, but will, of 
course, lower temporal resolution. Even a 1 Hz frame rate, however, is much greater resolution than most 
hand scoring and is sufficient to measure differences among animals with high reliability.
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Stimulus Configuration

Sounds

Selector. You may configure up to 10 different sound stimuli, each of which can be selected for any 
stimulus epoch in a protocol. Select one of the 10 sound stimuli to configure by clicking on the listbox to the 
left of the window. Sounds once configured are stored in a file and need not be updated each time the 
program is used. 

Hiss/Tone. To the left, set whether the sound stimulus will be a white noise (hiss) or pure tone.

Frequency. If a tone, use the Frequency control to set the tone's pitch.

Amplitude. Adjusts the relative amplitue of the sound, from off (0) to the loudest your amplifier can 
produce (100).

Pulse. When on, the sound will be presented discontinuously during a stimulus epoch, 250 on - 250 off.

Rise Time. At sound onset, the amplitude will increase linearly to the maximum over 
the number of milliseconds indicated. Similarly, at offset the amplitude diminishes 
linearly from the maximum to reach zero at the end of the sound. 
Frequency. Determines the frequency of pulsation. 
Duty cycle. Determines for what percentage of each cycle the pulsing sound is on.

Test. Momentarily turns on the sound as currently configured. If no sound can be heard, check the speaker 
connections, volume setting and sound card configuration in Windows. 

Shocker and auxilliary stimulus outputs

Invert. 1 (PCI-1405/7) or 3 (PCI-1408/9/10) slide switches will appear that allow you to determine the 
polarity of the outputs for the shock (stimulus 2) and the auxilliary outputs (stimulus 3 and 4). When in the 
Norm position, the corresponding input will be low (0V) when off and high (5V) when on. In the Invert 
position, the stimulus will be inverted.

Test. While pressed, puts all three outputs in their ON state (high for Norm and low for Invert). Otherwise, 
the outputs are in their OFF state (low for Norm and high for Invert).
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File Formats

FreezeFrame store several different types of files. All files are created automatically in the current Data 
directory, which is directory in which the currently selected Data file is located using the FILE->OPEN 
menu item in the main FreezeFrame window.

FFDD data files. The frame-by-frame motion index is stored in a file with the extension "ffdd". When the 
data file is opened from the FreezeView program, the entire list of animals contained in that file is displayed.

For multicomputer systems, the Master computer's data file stores data from all animals on both the Master 
and Remote computers. On the Remote computers, only the data collected by that computer is stored in the 
data file.

Log file. FreezeFrame creates a text file that contains a list of all the animals run. 

FFII Image Files. With the Save Images option selected (Settings->Save Images menu item in the main 
FreezeFrame window) FreezeFrame creates one image file for each animal in a trial. The name of the file is 
the name typed into the corresponding element of the Name control in the main window, and the extension 
is ".ffii". Each image is stored as a 2-D array of 8-bit unsigned integers, preceded by 2 4-byte integers that 
specify the size of the array. These bytes are stored in big-endian format (most significant byte first). Images 
can be converted to QuickTime format (with the extension .mov) using the FreezeView program. 

Image files tend to be large. At 4 frames per second, the 320 x 240 pixel arrays accumulate at 18 MBytes per 
minute. If you are planning to save image files, a large hard drive and a mass storage backup device such as 
a fast CD or DVD writer are helpful.

FFTT threshold files. When you analyze the trials stored in a data file, the thresholds you choose for 
freezing are stored in a file with the same name as the data file, but with the fftt extension.
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Data collection trouble shooting

No image

The most common trouble is the lack of an image in the image window. When this 
happens, the program gets very sluggish to respond. 
Check to make sure the camera is connected to the computer properly and that the 
power is connected to the camera. 
Once you check the connections for faults, stop and restart FreezeFrame to see if the 
image now appears. 
Another convenient way to troubleshoot the camera input is using the Measurement 
and Automation Explorer that comes with the PCI-140X drivers. The icon for this 
program is on the desktop. Choose the Devices window, and then the 140X board. Use 
Snap or Grab to view the image from each camera.

Portions of the image (usually a horizontal strip) appear black. 

Open the Measurement and Automation Explorer ("MAX", its icon is installed on the 
desktop by NI-IMAQ).  
Open the Devices and Interfaces folder and select the image acquisition board (PCI-
140X). 
Select Channel 0 and click the Grab button in the toolbar. Expand the MAX window 
so that you are able to see the intire image.  
If the black areas appear in the image, click Properties button in the toolbar and adjust 
the image limits (top, left, width and height) until the black areas disappear. Width 
should be set to 640, height to 480, and left to approximately 115.

The program seems not to be detecting small movements of the animal.

In order for FreezeFrame to be maximally sensitive to movement, the image of the 
shock cage should fill as much of the image as possible. In the 1-camera/4-chamber 
system, this can sometimes be difficult. Keep the 4 chambers as close together as 
possible by sliding them toward the center of the image, and raising the lower set of 
cages to be just underneath the upper set. In some cases, it might be necessary to 
convert to a 4-camera system so that each cage can be individually adjusted to fill it 
corresponding image. 

The shocker does not seem to turn on at the appropriate times.
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The usual cause for this problem is improper connection of the trigger output of the 
image acquisition board to the shocker. To make sure that the FreezeFrame program 
and its output is functioning properly, disconnect the trigger output from the shocker 
and measure voltage on the output with a voltmeter or oscilloscope. It should be within 
a few tenths of a volt of 0V when off, and within a few tenths of 5V when on (or vice 
versa if the invert control is on in the Stimulus Setup Window. If the voltages are 
correct, then contact the manufacturer of your shocker to help with the proper 
connections. 

Trials seem to give inconsistent or highly variable results.

The most common cause of inconsistent results from trial to trial is problems in 
delivering the shock to the animals. The shock cage is a harsh environment for 
electrical connections: urine is very corrosive and the contacts between connectors and 
shock bars often fail. Check the video of trials in which animals are not freezing much 
to see that they are receiving the shock. Use an oscilloscope or voltmeter to check that 
each bar is receiving the shock signal. (It is good practice to do this on a regular basis, 
as often as once per week.) Clean the contacts in the electrical pathway between the 
shocker and the grid bars. On removable floor trays, check to see that the bars have not 
slid forward, especially the bars near the sides of the cages. If they have, they will no 
longer make good contact. 

A second (though less common) problem that might cause inconsistent results can 
occur if the program is not detecting motion reliably. See the item "The program 
seems not to be detecting small movements of the animal" above.

No data from Remote computer (MultiComputer Systems only)

Check the cables that connect the Master computer to the Remote. COM1 on the 
Master computer should be connected to COM1 of Remote 1, and COM2 of the 
Master computer should be connected to COM1 of Remote 2.

Data analysis trouble shooting
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The Analysis Program (FreezeView)

Opening a data file 

Open File. Click on the FILE -> OPEN menu item to select a file for analysis (or 
double-click filename indicator). A standard Open File Dialog lets you navigate 
through the Windows file system to find a data file with the .ffdd extension.

Selecting an animal for analysis

Once a file is selected, the Animals list box at the right of the window shows the 
animals for which data were collected.Select an animal either by clicking on it or by 
using the UP and DOWN arrow keys to scroll through the list. As you scroll through 
the list, the displays are updated to show the data for the selected animal.Animals for 
which image files are available (in the same folder as the data file) are prefixed with *. 

Displays

●     The motion index as a function of time. The data in the motion index graph can be written to a 
spreadsheet readable file by selecting the ANALYSIS -> EXPORT INDEX GRAPH menu item.

●     Freezing as a function of time. Freezing is set to 0 or 1 depending on whether the motion index 
exceeds the freezing threshold. 

●     The stimuli as a function of time. The time during which each of the 4 possible different stimuli 
are on are shown as yellow, cyan, red and green fills.

●     A histogram of the motion index (lower left graph). The data in the motion index histogram can 
be written to a spreadsheet readable file by selecting the ANALYSIS -> EXPORT HISTOGRAM 
menu item.

●     Percent freezing.The numeric indicators show the percent time the animal spent frozen (see here 
for details) 

�❍     while each of the stimuli was on (stimulus 1, stimulus 2...),
�❍     while each of the stimuli was off (not stimulus 2, not stimulus 2...),
�❍     for the whole trial (Total), and 
�❍     while all stimuli were off (no stimuli).

 

Setting the Freeze Parameters
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Freeze Threshold (Histogram cursor) A criterion level must be chosen for deciding 
when the animal has frozen. Set the freeze threshold by dragging the vertical blue 
cursor in the histogram display (lower left) or 
by using the digital Threshold indicator. The 
value is chosen by examining the motion index 
histogram. For most animals, there will be a 
large, narrow peak starting at 0 (freezing), and 
a second, broader peak between 50 and 100 
(activity). There will be, in addition, a distinct 
trough between the two peaks in the range of 
20-30. The threshold should be set to the value 
of the trough. To the right are shown examples 
of 5 histograms with the threshold set properly. 
The white text indicates the % freezing for the 
trial. Note the different scales for the different 
graphs.

Some animals freeze very little (10% graph) 
and so have only a small peak or no peak at all 
at zero. Some animals freeze almost all the 
time (50% graph), and so the peak near zero 
will dominate with only scattered points at 
higher values.

You may set the threshold for each animal individually, or use the Set all button to set 
the threshold for all trials in the file to the current value. But if you use the Set all 
button, check each trial to make sure the thresholds are valid. 

Thresholds are saved in a file with the same name as the data file, but with a 
different extension ".fftt". When moving data files to a different folder, bring the 
corresponding ".fftt" file along in order to maintain the previously set thresholds.

You can often see the appropriate threshold by looking at the Freeze Index vs. Time 
graph (upper right of the window) at a high vertical gain. To increase the vertical gain 
in the index graph in order to examine the periods of inactivity in more detail, double-
click on the top number on the vertical scale and the desired range (e.g. 10), then hit 
<enter>. Below are images of the Freeze Index graph for a trial at normal vertical gain 
and then expanded to see the bouts of freezing in more detail. When the threshold is 
set properly, small changes in either direction should have only small effects on the 
Totoal % Freezing
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Bout (s)

Bout length is the duration that a single freezing episode must equal or exceed in order 
to be counted. With Bouts set to 1, for example, episodes of freezing (that is, episodes 
during which the motion index is continually below thresheld) that last only 0.75 s or 
less will be treated as if the animal had not frozen at all during that period. As Bout 
and Threshold are changed, the freeze graph and % Freeze indicators will be updated 
to reflect the new parameters.

Displaying images 

If an image file for the selected animal is present in the same directory as the open data 
file, several buttons will appear over the image window (lower right) that can be used 
to play the image file as a movie.

Time cursor. The vertical blue cursor in the Freeze Index graph (top) is used to 
control the time at which the playback starts. For example, drag the cursor to time t = 
10 sec, and press one of the playback controls to start the movie from that time. As the 
movie plays, the cursor moves to indicate the progress of the playback through the 
trial. 

Playback controls.
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> Plays the image at near real time, starting at the time in the 
trial set by the vertical blue cursor in the Freeze Index graph 
(top). Click the control again (or click the || control) to stop the 
playback. 
>> Plays the image as fast as the computer will go. Playback 
starts at the time in the trial set by the vertical blue cursor in the 
Freeze Index graph (top). Click the control again (or click the || 
control) to stop the playback. 
>| Advances one frame per click of the control. 
<< Plays the image in reverse as fast as the hard drive and 
processor will go. 
|| Stops playback..

TV/Difference. You may view the images as recorded, or as the pixel-by-pixel 
difference between the current image and the previous image. 

The VIDEO -> INVERT VERTICAL and INVERT HORIZONTAL menu items flip 
the image vertically and horizontally.

Multicomputer Systems: When analyzing data files on the Master computer, index 
data are available for all animals recorded on all computers. Images are only available 
for animals whose image files are located in the data file directory. To view images for 
animals recorded on the Remote computers, you must transfer the image files for those 
animals to the Master computer (to the same directory as the data file). Or run the 
analysis program on the Remote computer. 

Exporting QuickTime and AVI Movies/Compressing Image Files

It is possible to export QuickTime movies of all or part of a trial. These movies can be 
displayed in PowerPoint and other image presentation software. It is also possible to 
use QuickTime to compress the image files for viewing within FreezeView, greatly 
reducing the disk space required to store them.

Exporting Analyses

The program allows exporting of several statistical measures of freezing.
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Exporting Analyses

To Export data, open the Analysis window by selecting the ANALYSIS -> EXPORT STATISTICS menu 
item in the main program window.

Interval Type

There are 3 different ways to specify the intervals for analysis.

●     Fixed Interval. Divides the trial into periods of equal duration. The interval duration is set in the 
Interval (sec) that appears when Fixed Intervals are chosen. A graph of the %Freeze as a function 
of time is shown.

●     Custom Interval. You may specify any number of intervals of arbitrary start time and duration. 
First specify the number of intervals. Then fill in the onset time and duration of each interval in 
the correspondign text edit boxes.

●     By Stimuli. This analysis is similar to the indicators in the main window. The analysis is 
performed on: 

�❍     The total duration of the trial
�❍     The time during which stimulus 1 (the sound) is on
�❍     The time during which stimulus 2 (the shock) is on
�❍     The time during which stimulus 3 is on
�❍     The time during which stimulus 4 is on
�❍     The time during which no stimulus is on
�❍     The time during which stimulus 1 (the sound) is not on
�❍     The time during which stimulus 2 (the shock) is not on
�❍     The time during which stimulus 3 is not on
�❍     The time during which stimulus 4 is not on 

Note that a stimulus may come on more than once during a trial. If, for example, 
stimulus 1 is on for the first and 3rd minutes of a 6 minute trial, Stimulus 1 on include 
both of those minutes, and Stimulus 1 not on includes minutes 2, 4, 5, and 6.

Analysis Parameter 

●     Once the intervals are chosen, the parameter for analysis must be chosen. The 4 choices are

●     Percent Freezing. The percent of the time during which the animal was frozen.
●     Number of bouts. The number of continuous bouts of freezing.
●     Mean bout interval. The mean time between the start of consecutive bouts.
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●     Mean bout duration. The mean duration of bouts. 

The selected parameter is calculated for each of the specified periods and displayed in the text 
box to the right of the window. Note that for all analyses, bouts of duration less than the Bout 
duration specified in the main window are excluded. 

Note that when By Stimuli is the interval type chosen, the only analysis parameter available is 
Percent Freezing.

Exporting

Pressing the Export button performs the chosen analysis on each one of the trials 
(animals) in the open experiment file. The resulting data are written to a comma-
delimited (csv) file, which can be opened in Excel or other statistical programs. If the 
button labelled "Open Excel" is set to the ON position, the file created will be opened 
automatically in Excel (assuming Excel is installed on the computer).

Trials in: Rows/Columns

This control determines the orientation of the data in the Excel spreadsheet. 
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Compressing and Exporting Image Files

FreezeFrame saves images in an uncompressed or raw format in the *.ffii files that are located in the same 
folder as the.fftt data file. In these files, the luminance value for each pixel of each frame is stored in a large 
2-dimensional array. This scheme has the advantage of being fast, increasing the frame rate at which 
FreezeFrame can work. And the uncompressed format preserves all of the information in the images. The 
disadvantages of the raw ffii files are their large size and their incompatibility with other video presentation 
and editing programs. FreezeView contains 2 utlilities for converting the raw image files to ones that are in 
more standard video formats, compressing them at the same time. 

In order to create QuickTime and AVI movies, the Windows version of Apple's QuickTime Player 
must be installed on your computer. Only the free QuickTime player is required. It is available from Apple 
at http://www.apple.com/quicktime. 

Exporting images

From the Main FreezeView window, you may export all or part of the video stream for the currently selected 
animal. The resulting QuickTime (.MOV) or AVI files can be read into PowerPoint, placed on web sites or 
used in other presentation software. To export:

●     Use the Video controls to move the Time Cursor (vertical light blue line in Motion Index graph) 
to the start of the portion of the trial you would like to export. Or drag the Time cursor directly. 

●     Select the ANALYSIS -> EXPORT MOVIE menu item. A Compression Settings window will 
appear.

●     Select QuickTime or AVI 
●     Pick a Compression format using the Format pull-down menu. There are a daunting number of 

formats available with QuickTime. We recommend MPEG 4 (MP4) for QuickTime or Indeo 
Video for AVI. 

●     Pick the level of compression using the Compression control. This setting will determine how 
compact the exported file will be. Low settings will give higher compression, lower image 
quality, and smaller files. Try exporting a short video clip with different settings to see which will 
suit your needs. 

●     Select the Playback speed. This will determine whether the video clip plays back in QuickTime 
at near real-time, twice real time, 3x or 4x real time.

●     Click OK or Cancel and the Compression settings window will close. 
●     A file dialog will appear. Specify a filename for the exported image file. The appropriate 

extension (.MOV or .AVI) will be appended automatically.
●     Once the file dialog closes, in the main FreezeView window, the video control buttons will have 

changed color. Play the desired portion of the video using the now-green video control buttons (>| 
 >  >>). While the controls are green, each displayed frame of the video will be stored to the 
QuickTime file of the selected filename. Note that using the different play buttons does not affect 
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the playback speed you will see when you play the file in the QuickTime player. They only affect 
how quickly the file is written and displayed in FreezeView. The Playback Speed control in the 
Compression Settings Window determines how fast the video will play in QuickTime.

●     Click the red stop-playback button (||) to close the movie file. 

To playback the newly created QuickTime or AVI video file, double-click its icon in Windows 
Explorer and it will open in the QuickTime Player or Windows Multimedia Player. The file can 
also be imported into PowerPoint, html files or other multimedia files. 

Warning. Do not try to overwrite an existing QuickTime file while the file is open in the 
QuickTime Player. An error will result.

Compressing the image files for playback in FreezeView

It is also possible to compress all the FreezeView image files associated with a data file in one batch 
operation. That is, you can copy all the images from each raw image file to compressed, QuickTime-
compatible *.MOV or *.AVI files. When you then play a video from within the FreezeView program, the 
images shown will come from the newly created QuickTime file rather than the original raw video file. The 
advantage is that the QuickTime files can be 10 or more times smaller than the ffii files, and so occupy less 
disk space. The disadvantage is that the compressed images are not quite as sharp as the originals, depending 
on the level of compression chosen. As with files written one at a time with the EXPORT MOVIE function, 
the image files created en masse can also be played in the QuickTime Viewer, PowerPoint etc. To compress 
all the image files in the folder containing the currently opened data file: 

●     Select the VIEW->COMPRESS IMAGE FILES menu item. 
●     The Compression Settings Window will appear.
●     Pick a Compression format using the Format pull-down menu. We recommend MPEG 4 (MP4). 
●     Pick the level of compression using the Compression control. The setting will determine how 

compact the exported file will be. Low settings will give higher compression, lower image 
quality, and smaller files. Try exporting a short video clip with different settings to see which will 
suit your needs. MP4 with a compression setting of about 350 gives 10-fold compression and yet 
gives a very nice image. 

●     Select the Playback speed. This will determine whether the video clip plays back in QuickTime 
at near real-time, twice real time, 3x or 4x real time. It will NOT effect the speed at which the 
files play in the FreezeView program itself.

●     Click OK and the Compression settings window will close (or select Cancel to stop the 
compression process).

●     A new window will open. The uncompressed images are displayed as they are being compressed 
and stored. Various indicators show the file currently being compressed, the progress through the 
list of files, the progress in the current compression, the compression format being used and the 
compression ratio acheived (that is, the size of the compressed file expressed as a percent of the 
size of the raw file).You may cancel the process at any time. 

●     When all the ffii files in the folder have been compressed, the window will close.
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During the compression process each file named <animal>.ffii, is compressed and stored in a new file called 
<animal>.MOV or .AVI. Whenever a file called <animal>.MOV or .AVI is present in the data folder, 
FreezeView will automatically use it when displaying images, even if the corresponding <animal>.ffii file is 
also present. You may therefore discard the original ffii files once you have decided that you are satisfied 
with the level of compression and the quality of the images. We recommend that you archive the original 
files on CD, DVD or tape if possible. But this is not required. 
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Tail Suspension Data Collection

FreezeFrame can be used for collection of data from tail suspension experiments. Set up the video card, 
cameras and FreezeFrame program the same as you would for fear conditioning experiments. You may use 
one camera for 4 animals (placed in the 4 quadants of the image), or record 1 animal each with up to 4 
cameras. 

Set-up

Aim the camera horizontally toward the animal from one side

Put a uniform background background behind the animal for maximum contrast (white or light gray for dark 
animals; black or dark gray for white animals. 

Adjust the field of view (zoom and camera distance) so that the animal is near or slightly below the center of 
the screen. Include all of the tail and some of the tail support in the image. 

Adjust the lighting so that the shadow of the animal is not directly behind the animal. Light from above and 
slightly in front of the animal. Or for dark animals on the light background, the lights can be put above the 
animal, between the animal and the background. 

Recording

Record trials using the FreezeFrame program as for fear conditioning. Set up the duration of each trial in the 
Protocol window. During the trial, the program will calculated freezing as normally does for fear 
conditioning. These numbers are not useful for Tail Suspension, but you will reanalyze the records for tail 
suspension using the Tail Suspension analysis program. 
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Tail Suspension Data Analysis

Install and run the Tail Suspension program. 

Opening a data file 

Open File. Click on the FILE -> OPEN menu item to select a file for analysis (or double-click filename 
indicator). A standard Open File Dialog lets you navigate through the Windows file system to find a data file 
with the .ffdd extension.

Selecting an animal for analysis

Once a file is selected, the Animals list box at the right of the window shows the animals for which data 
were collected.Select an animal either by clicking on it or by using the UP and DOWN arrow keys to scroll 
through the list. As you scroll through the list, the displays are updated to show the data for the selected 
animal.Animals for which image files are available (in the same folder as the data file) are prefixed with *. 

Re-tracking a trial for Tail Suspension

When FreezeFrame records a trail, it calculates a freeze index appropriate for fear conditioning. In order to 
measure motion for Tail Suspension, you will need to reanalyze each trial. This only needs to be done the 
first time you view a trial. For safety, make and store a copy of the ffdd file before you modify with the 
Tail Suspension program. The video (ffii) files are not affected, so there is not need to copy them other 
than for standard backups.

●     Select a trial in the list to the right of the main analysis window.
●     Select the ANALYSIS ->TAIL SUSPENSION menu item. 
●     Use the yellow cursors to select an area around the animal. Include the tail, but not the supporting 

apparatus. Include an area around the animal about twice its size. 
●     Select Realine or Fast using the toggle switch at the upper right to determine how the trial will be 

displayed during analysis.
●     Set the tracker 

�❍     Select the animal color. AUTO for auto detection, or white or black for light or dark 
animals. 

�❍     Set Threshold method to AUTO
�❍     Set Area threshold to 25
�❍     Set Manual threshold to 100

●     Click the Run button and let the trial complete. 
●     Select the SAVE (or CANCEL) menu item either to save (or ignore) the new analysis and return 
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to the main Window.

Setting the Freezing Threshold

Once a trial has been retracked for tail suspension, start analysis with the Threshold parameter to 1. This 
setting should be well above the index that occurs during long bouts of inactivity, and below the index when 
the animal is active. Depending on how large the animal is in the image, the appropriate value of threshold 
might be slight larger or smaller that 1, but not by more than a factor of 2. As for the FreezeView program, 
you can increase the vertical gain in the index graph in order to examine the periods of inactivity in more 
detail: double-click on the top number on the vertical scale and the desired scale (e.g. 10), then hit <enter>. 

Use the same Threshold for all trials.

Most other features of the program are identical to those in the FreezeView program. For details of analysis 
and exporting of trial data, see the instructions for the program. For all exports, the numbers reported are 
related to inactivity (freezing), not activity. 
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